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1บทที่ 1 ก้าวแรกก่อนเข้าสู่โลกของ .NET

C# 11บทที่

1
ก้าวแรกก่อนเข้าสู่โลกของ .NET

แพลตฟอร์ม .NET (.NET Platform) ยังคงได้รับความนิยมต่อเนื่องมาอย่างยาวนานจนถึงยุค

ปัจจุบัน หนังสือเล่มนี้น�ำเสนอการเขียนโปรแกรมด้วยภาษา C# ถือเป็นภาษาหลักของแพลตฟอร์ม 

.NET เป็นอีก 1 ทางเลือกที่ผู้อ่านสามารถเริ่มต้นหัดเขียนโปรแกรมได้อีกด้วย

ท�ำความรู้จักกับแพลตฟอร์ม .NET 
(.NET Platform)

แพลตฟอร์ม .NET (.NET Platform) เป็น Framework ที่ไมโครซอฟท์สร้างขึ้นมา รองรับการ

เขียนโปรแกรมมากมายหลายภาษา เพื่อสร้างแอปพลิเคชันในรูปแบบพื้นฐาน 3 อย่าง ได้แก่

1.	 Desktop Apps หมายถึง แอปพลิเคชันที่รันบนระบบปฏิบัติการ Windows

2.	 Web Apps หมายถึง การสร้างเว็บแอปหรือสร้างเว็บไซต์ขึ้นมา

3.	 Mobile Apps หมายถึง การพัฒนาแอปส�ำหรับรันบน Android และ iOS

เราสามารถแบ่งยุคสมัยของ .NET ได้ 3 ช่วงคือ

1.	 .NET Framework (เวอร์ชัน 1.0 ถึง 4.x) เป็นยุคเริ่มต้นของแพลตฟอร์ม .NET นักพัฒนา

สามารถพัฒนาโปรเจ็กต์ประเภทต่างๆ บนระบบปฏิบัติการ Windows เท่านั้น เรียกว่า ยุค 

.NET Framework

2.	 .NET Core (เวอร์ชัน 1.0 ถึง 3.x) ไมโครซอฟท์ปรับปรุงให้แพลตฟอร์ม .NET สามารถ

พัฒนาโปรเจ็กต์ในรูปแบบ Cross-Platform บน Windows, macOS และ Linux เรียกว่า 

ยุค .NET Core 
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3.	 .NET (เวอร์ชัน 5.0 และเวอร์ชันใหม่กว่า) ไมโครซอฟท์ยุบ .NET Framework และ .NET 

Core เข้าด้วยกัน ตั้งชื่อใหม่ว่า .NET ไม่มีอะไรต่อท้าย เริ่มต้นที่ .NET 5.0 และก�ำหนดให้

มีการออก .NET เวอร์ชันใหม่ปีละ 1 รุ่นในเดือนพฤศจิกายนของทุกปี เรียกว่า ยุค .NET

ขอบเขตการน�ำเสนอของหนังสือเล่มนี้
เนื้อหาที่จะน�ำเสนอในหนังสือเล่มนี้ ครอบคลุมการพัฒนาโปรแกรมบน Desktop Apps และ 

Web Apps โดยอาศยัภาษา C# ในระดับเบือ้งต้นเท่าน้ัน แต่ก็มีเน้ือหาสาระเพียงพอทีจ่ะน�ำไปต่อยอด 

ในล�ำดับต่อไป ประกอบด้วยเนื้อหา 5 ส่วนใหญ่ๆ คือ

1.	 ศึกษาไวยากรณ์ภาษา C# อัพเดตเนื้อหาเริ่มต้นที่ C# 11 ที่มากับ .NET 7 เป็นต้นไป

2.	 พัฒนาแอปท�ำงานกบัระบบฐานข้อมูล SQL Server ด้วย Entity Framework Core เรียกส้ันๆ  

ว่า EF Core

3.	 แนะน�ำการพัฒนา Web Apps ด้วย ASP.NET Core MVC 

4.	 แนะน�ำการพัฒนา Web API ด้วย ASP.NET Core Web API

5.	 แนะน�ำการพัฒนาแอปแบบ Container ของแพลตฟอร์ม .NET

ท�ำความรู้จักกับประเภทโปรเจ็กต์ที่น่าสนใจ
ในขั้นต้น

โปรแกรม Visual Studio รองรบัการพฒันาแอปในแพลตฟอร์มต่างๆ มากมาย ผูอ้า่นสามารถ

แยกติดตั้งแต่ละประเภทอย่างชัดเจน ที่น่าสนใจในขั้นต้นมีดังนี้

1.	 ASP.NET and web development การพัฒนา Web Apps หรือสร้างเว็บไซต์ในโลกของ 

.NET/.NET อยู่ในความรับผิดชอบของโปรเจ็กต์ประเภท ASP.NET มีโปรเจ็กต์ที่น่าสนใจ 

คือ ASP.NET CORE MVC และ ASP.NET Web API

2.	 Python development ใช้ส�ำหรับเขียนโปรแกรมภาษาไพธอน

3.	 Azure development เป็นโปรเจก็ต์ทีร่องรับการใช้บริการต่างๆ บน Cloud ของไมโครซอฟท์  

เรียกว่า Azure

4.	 Node.js development เป็นแพลตฟอร์มที่ใช้ส�ำหรับสร้าง Web Apps หรือสร้างเว็บไซต์

โดยอาศัยภาษา JavaScript ทั้งฝั่ง Client และฝั่ง Server เพียงภาษาเดียว เรียกว่า MEAN 

Stack
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5.	 .NET desktop development เป็นโปรเจ็กต์ที่ใช้สร้างแอปที่ติดต้ังบน Windows ที่เรา 

คุ้นเคยกันเป็นอย่างดีคือ ไฟล์นามสกุล .exe หรือ .msi โดยอาศัยภาษา VB หรือ C# นั่นเอง 

เช่น โปรเจ็กต์ประเภท Windows Forms Application, WinUI และ WPF เป็นต้น

6.	 Universal Windows Platform development เป็นโปรเจ็กต์ที่ใช้ส�ำหรับสร้างแอปที่ติดตั้ง

บน Windows 10 

7.	 Desktop development with C++ เป็นโปรเจก็ต์ทีใ่ช้สร้างแอปทีติ่ดต้ังบน Windows เช่นกนั  

แต่ใช้ภาษา C++

8.	 .NET Multi-platform App UI development การพัฒนา Mobile Apps ในโลกของ .NET 

เป็นหน้าที่ของโปรเจ็กต์ที่เรียกว่า .NET MAUI กับ .NET MAUI Blazor สามารถพัฒนาได้

ทั้ง iOS/Android Apps และ Desktop Apps ในโปรเจ็กต์เดียวกันอีกด้วย

การดาวน์โหลดและติดตั้งโปรแกรม 
Visual Studio 2022

การพัฒนาโปรแกรมในโลกของ .NET มีหลายวิธี หนังสือเล่มนี้อาศัยโปรแกรมที่ชื่อว่า Visual 

Studio 2022 มี 2 แบบคือ

1.	 โปรแกรม Visual Studio เวอร์ชันปกต ิเป็นเวอร์ชันทีเ่หมาะกับการน�ำไปใช้ในงาน Production  

จริง สามารถดาวน์โหลดมาใช้งานได้ฟรีที่ https://visualstudio.microsoft.com/vs/

คลิก1

รูปที่ 1-1 แสดงเว็บส�ำหรับดาวน์โหลดโปรแกรม Visual Studio เวอร์ชันปกติ
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2.	 โปรแกรม Visual Studio เวอร์ชัน Preview เป็นเวอร์ชันที่เหมาะสมกับกรณีที่ต้องการ

ทดสอบฟีเจอร์ใหม่ๆ ก่อนใคร มีความเสี่ยงกับบั๊กและ Error ต่างๆ มากกว่าเวอร์ชันปกติ 

ไม่แนะน�ำให้ใช้เวอร์ชันน้ีกบังาน Production จริง ใช้แค่ในระดับศกึษาเท่าน้ัน สามารถโหลด

มาใช้งานฟรีได้ที่ https://visualstudio.microsoft.com/vs/preview/

ฟีเจอร์ต่างๆ ที่ถูกน�ำมาทดสอบในเวอร์ชันน้ี เม่ือผ่านการทดสอบแล้วไมโครซอฟท์จะน�ำไป 

ใช้งานกับเวอร์ชันปกติในล�ำดับถัดไป ดังรูปที่ 1-2

คลิก2

รูปที่ 1-2 แสดงเว็บส�ำหรับดาวน์โหลดโปรแกรม Visual Studio 2022 เวอร์ชัน Preview

ผู้อ่านสามารถติดต้ังโปรแกรม Visual Studio 2022 ทัง้ 2 เวอร์ชันได้ในเคร่ืองเดียวกนั ต่างคน 

ต่างอยู่ โดยมีวิธีการติดตั้งเหมือนกันดังนี้

1.	 ให้ผู้อ่านเลือกดาวน์โหลดตัวติดตั้งโปรแกรม Visual Studio 2022 Community Edition 

มาก่อน ดังรูปที่ 1-3

คลิก1

รูปที่ 1-3 แสดงการดาวน์โหลดตัวติดต้ังโปรแกรม Visual Studio 2022
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2.	 ให้ผู้อ่านดับเบิลคลิกไฟล์ที่ดาวน์โหลดมา เพ่ือเข้าสู่ข้ันตอนการติดต้ังโปรแกรม Visual  

Studio 2022 ผู้อ่านสามารถเลือกประเภทโปรเจ็กต์ที่สนใจได้อย่างอิสระ ขอบเขต 

การน�ำเสนอเนื้อหาของหนังสือเล่มนี้ ประกอบด้วย

�	 ASP.NET and web development ส�ำหรับพัฒนาโปรเจ็กต์ประเภท Web Apps

�	 .NET desktop development ส�ำหรับพัฒนาโปรเจก็ต์ทีรั่นบนระบบปฏิบติัการ Windows

คลิก 2.1

คลิก 2.2

คลิกเพื่อเริ่มดาวน์โหลดและติดตั้งรายการที่เลือกไว้ 2.3

รูปที่ 1-4 แสดงหน้าจอเลือกติดต้ังประเภทโปรเจ็กต์

3.	 ท้ายที่สุด ให้ผู้อ่านรอการดาวน์โหลดและติดต้ังรายการต่างๆ ตามที่ผู้อ่านเลือกจนเสร็จ

สมบูรณ์ ถือว่าโปรแกรม Visual Studio 2022 พร้อมใช้งานแล้ว ดังรูปที่ 1-5
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รูปที่ 1-5 แสดงการติดต้ังโปรแกรม Visual Studio เสร็จสมบูรณ์
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C# 11การติดตั้ง .NET SDK เพิ่มเติม
เนื้อหาหนังสือเล่มนี้ต้องการ .NET SDK เวอร์ชัน 7 ขึ้นไป ผู้อ่านสามารถติดตั้ง .NET SDK 

หลายเวอร์ชันในเวลาเดียวกัน ส่งผลให้โปรแกรม Visual Studio 2022 ของผู้อ่านสามารถสร้าง 

โปรเจ็กต์ได้ตามเวอร์ชัน .NET SDK ที่ถูกติดตั้งในเครื่องของคุณ มีขั้นตอนดังนี้

1.	 ให้ผู้อ่านไปที่เว็บไซต์ https://dotnet.microsoft.com/en-us/download/dotnet เพ่ือ

ดาวน์โหลด .NET 7 SDK เพ่ิมเติม (ในช่วงเวลาของผู้อ่านจะมีเวอร์ชันใหม่กว่าเสมอ)  

ดังรูปที่ 1-6

คลิก1.1

คลิก1.2

รูปที่ 1-6 แสดงการดาวน์โหลด .NET 7 SDK
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จากรูปที ่1-6 ผู้เขียนใช้งาน Windows 10/11 แบบ 64 บติ จงึเลือก .NET 7 SDK แบบ x64 (หรือ

เลือกเวอร์ชันทีใ่หม่กว่าตามทีต้่องการ) ผู้อ่านต้องตรวจสอบด้วยว่า .NET SDK ทีด่าวน์โหลดมาติดต้ัง

เองเพ่ิมเติม ต้องการโปรแกรม Visaul Studio เวอร์ชันใด ตรวจสอบได้ทีหั่วข้อ Visual Studio support

เมื่อมีการอัพเตด .NET SDK เวอร์ชันใหม่ ก็จะมีการอัพเดตโปรแกรม Visual Studio ควบคู่มาด้วยเสมอ เพื่อ

ให้สามารถใช้งาน .NET SDK เวอร์ชันใหม่ได้นั่นเอง โดยปกติแล้วโปรแกรม Visual Studio เวอร์ชัน Preview  

มักจะได้สิทธิ์ทดสอบ .NET SDK เวอร์ชันใหม่ก่อนเวอร์ชันปกติ

Note

2.	 ท้ายทีสุ่ด ให้ผู้อ่านดับเบลิคลิกไฟล์ทีด่าวน์โหลดมา เพ่ือเข้าสู่ข้ันตอนการติดต้ัง .NET 7 SDK  

ใช้ค่าเร่ิมต้นที่มากับตัวติดต้ังทั้งหมด ส่งผลให้โปรแกรม Visual Studio 2022 สามารถ

พัฒนาโปรเจ็กต์บน .NET SDK ได้หลายเวอร์ชัน

สถานะของ .NET SDK
หลังจากที่ไมโครซอฟท์รวม .NET Framework และ .NET Core เข้าด้วยกันกลายเป็นยุค .NET 

ในปัจจุบัน มีนโยบายออก .NET SDK เวอร์ชันใหม่ปีละ 1 รุ่น มีสถานะแตกต่างกันกล่าวคือ

�	 .NET SDK เวอร์ชันเลขคี่ ได้แก่ เวอร์ชัน 5, 7, ... มีระยะเวลาสนับสนุนอพัเดตแพตช์แก้ไข  

18 เดือน

�	 .NET SDK เวอร์ชันเลขคู่ ได้แก่ เวอร์ชัน 6, 8, ... มีระยะเวลาสนับสนุนอพัเดตแพตช์แก้ไข 

3 ปี เป็นเวอร์ชันที่เรียกว่า Long-term support เรียกย่อๆ ว่า LTS การพัฒนาโปรเจ็กต์ใน

ระดับ Production จริง ผู้เขียนแนะน�ำให้เลือกใช้เวอร์ชัน LTS เหมาะสมที่สุด

รูปที่ 1-7 แสดงรายละเอียดของ .NET SDK แต่ละรุ่น
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.NET SDK เวอร์ชันใดก็ตามที่ใกล้หมดระยะเวลา Support เรียกว่า ระยะ Maintenance ถ้า 

โปรเจ็กต์ของเราใช้เวอร์ชันที่มีสถานะนี้ ควรที่จะอัพเดตไปใช้เวอร์ชันที่ใหม่กว่าให้เร็วที่สุด

ส่วน .NET SDK เวอร์ชันเก่าที่หมดช่วงเวลาระยะเวลา Support แล้ว ก็จะถูกจัดให้อยู่ในกลุ่ม 

Out of support versions เป็นเวอร์ชันที่ไม่แนะน�ำให้ใช้งานในระดับ Production จริงแล้ว

การติดตั้งฟอนต์ Cascadia Code ส�ำหรับ
เขียนโค้ดโดยเฉพาะ

ไมโครซอฟท์สร้างฟอนต์ส�ำหรับเขียนโค้ดโดยเฉพาะข้ึนมา ช่ือว่า Cascadia Code สามารถ 

ดาวน์โหลดมาใช้งานได้ทีเ่ว็บไซต์ https://github.com/microsoft/cascadia-code/releases ดังรูปที ่1-8 

คลิก1
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รูปที่ 1-8 แสดงเว็บไซต์ที่ให้ดาวน์โหลดฟอนต์เขียนโค้ด

จากรูปที ่1-8 ให้แตกไฟล์ zip ทีไ่ด้มา เราสนใจฟอนต์ทีมี่นามสกลุ .ttf เท่าน้ัน จะอยู่ในโฟลเดอร์

ทีช่ื่อว่า static ด้วย จากน้ันให้ผู้อ่าน Copy ฟอนต์ทีไ่ด้มาทัง้หมดไปวางไว้ในพาธ C:\Windows\Fonts 

รูปที่ 1-9 แสดงโฟลเดอร์ที่จัดเก็บรายการฟอนต์ในระบบ Windows 10/11

ให้ผู้อ่านเปิดโปรแกรม Visual Studio ข้ึนมา คลิกเมนู Tools > Options ทีหั่วข้อ Environment >  

Fonts and Colors เลือกใช้ฟอนต์ที่ชื่อว่า Cascadia Code Light
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เลือก1

เลือก 3

คลิก 4

เลือก 2

รูปที่ 1-10 แสดงการก�ำหนดให้โปรแกรม Visual Studio ใช้ฟอนต์ Cascadia Code Light

ข้อแตกต่างของฟอนต์ Cascadia Code กบัฟอนต์อืน่ๆ ทีน่่าสนใจคอื สามารถแสดงสัญลักษณ์พิเศษ

ทางภาษาได้ เช่น เคร่ืองหมายหัวลูกศร เกดิมาจากการพิมพ์เคร่ืองหมาย = ติดกบัเคร่ืองหมายมากกว่า > 

การก�ำหนดให้แสดงหมายเลขบรรทัด
ส่วนการก�ำหนดให้ VS 2022 แสดงหมายเลขก�ำกบัโค้ดในแต่ละบรรทดั โดยการคลิกเมนู Tools >  

Options… ให้ผู้อ่านไปทีหั่วข้อ Text Editor > All Languages คลิกเลือก Line numbers ดังรูปที ่1-11

เลือก1 เลือก2

คลิก 3

รูปที่ 1-11 แสดงการก�ำหนดให้แสดงหมายเลขก�ำกับโค้ดแต่ละบรรทัด
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การสร้างโปรเจ็กต์ Windows Forms App
โปรเจก็ต์แบบ Windows Forms App ถอืเป็นโปรเจก็ต์ทีเ่หมาะสมกบัการเร่ิมต้นเขียนโปรแกรม

มากที่สุด มีโครงสร้างโปรเจ็กต์ค่อนข้างง่าย โดยมีขั้นตอนดังนี้

1.	 ทีห่น้าจอเร่ิมต้น ให้ผู้อ่านเลือก New Project จากน้ันเลือกสร้างโปรเจก็ต์ประเภท Windows 

Forms App ดังรูปที่ 1-12

เลือก 1.1

คลิก 1.2

รูปที่ 1-12 แสดงการสร้างโปรเจ็กต์ Windows Forms App ของภาษา C#
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2.	 ก�ำหนดรายละเอียดให้กับโปรเจ็กต์ที่จะสร้างขึ้นมา โดยที่

�	 ช่อง Project name หมายถึง ชื่อโปรเจ็กต์ ในกรณีนี้ตั้งชื่อว่า BasicApps

�	 ช่อง Location หมายถึง พาธที่ใช้จัดเก็บโปรเจ็กต์ปัจจุบัน โดยการคลิกปุ่ม  เลือก

โฟลเดอร์ตามที่ผู้อ่านต้องการ ในกรณีนี้เก็บโปรเจ็กต์ไว้ที่พาธ D:\C# ดังรูปที่ 1-13

ตั้งชื่อโปรเจ็กต์ก่อน2.1

คลิกเลือกพาธที่จัดเก็บโปรเจ็กต์ 2.2

รูปที่ 1-13 แสดงการก�ำหนดรายละเอียดให้กับโปรเจ็กต์ที่จะสร้างขึ้นมา

3.	 ข้ันตอนน้ีเป็นการก�ำหนดว่า โปรเจก็ต์ Windows Forms App ทีจ่ะสร้างข้ึนมา ผู้อ่านต้องการ

ใช้ .NET SDK เวอร์ชันใด รายการทีป่รากฏข้ึนมาในข้ันตอนน้ี เป็นไปตามรายการ .NET SDK 

ทีผู้่อ่านติดต้ังในเคร่ือง เน้ือหาในหนังสือเล่มน้ีต้องการ .NET SDK 7 ข้ึนไป ดังรูปที ่1-14

 

รูปที่ 1-14 การก�ำหนดเวอร์ชันของโปรเจ็กต์
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1
2

3

4

5

รูปที่ 1-15 แสดงสภาพแวดล้อมของ VS 2022 แบบ Windows Forms Application

จากรูปที่ 1-15 รายละเอียดแต่ละหน้าต่าง มีดังนี้

�	 หมายเลข 1 แถบเครื่องมือส�ำหรับทดสอบโปรเจ็กต์ปัจจุบัน

�	 หมายเลข 2 แถบคอนโทรลส�ำเร็จรูป ท�ำหน้าท่ีออกแบบส่วนแสดงผล (User Interface 

เรียกย่อๆ ว่า UI) ภายในโปรเจ็กต์ของผู้อ่าน

�	 หมายเลข 3 ส่วนแสดงผลจ�ำลอง ผู้อ่านสามารถออกแบบส่วนแสดงผลให้กับหน้าจอ

ต่างๆ ได้ที่นี่ โดยการลากคอนโทรลต่างๆ มาวาดตามที่ผู้อ่านต้องการ

�	 หมายเลข 4 เรียกว่า หน้าต่าง Solution Explorer ท�ำหน้าที่แสดงโครงสร้างโปรเจ็กต์

ปัจจุบันของผู้อ่านว่า ประกอบไปด้วยไฟล์อะไรบ้าง

�	 หมายเลข 5 เรียกว่า หน้าต่างคุณสมบัติ (Properties) ท�ำหน้าทีแ่สดงคณุสมบติัต่างๆ 

ของคอนโทรลที่ก�ำลังถูกโฟกัสในส่วนแสดงผลจ�ำลองว่า มีคุณสมบัติอะไรบ้าง ผู้อ่าน

สามารถแก้ไขคณุสมบติัต่างๆ ได้ตามทีผู้่อ่านต้องการเช่นกัน เช่น ต้ังช่ือคอนโทรลได้ที่

คุณสมบัติ Name, ก�ำหนดสีพื้นหลังได้ที่คุณสมบัติ BackColor เป็นต้น

4.	 ต้องการก�ำหนดให้ Form1 ปรากฏอยู่กึ่งกลางหน้าจอ โดยการโฟกัสที่ Form1 ก่อน ที่

คุณสมบัติ StartPosition ท�ำหน้าที่ก�ำหนดต�ำแหน่งของ Form1 ผู้เขียนเลือกแบบ  

CenterScreen หมายถึง ให้ปรากฏขึ้นมากึ่งกลางหน้าจอ ดังรูปที่ 1-16
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แก้ไขคุณสมบัติ4

รูปที่ 1-16 แสดงการแก้ไขต�ำแหน่งของฟอร์มให้อยู่กึ่งกลางหน้าจอ

จากรูปที่ 1-16 ณ จุดนี้ เราได้โปรเจ็กต์ตามที่ต้องการแล้ว

การออกแบบส่วนแสดงผลด้วยคอนโทรล 
(User Interface - UI)

ไม่ว่าผู้อ่านจะสร้างโปรเจก็ต์ประเภทใดกต็ามใน Visual Studio ไมโครซอฟท์ก�ำหนดให้สภาพ

แวดล้อมของตัวโปรแกรม Visual Studio มีลักษณะคล้ายกันหรือใกล้เคียงกันมากที่สุดเท่าที่จะเป็น

ไปได้ เพื่อให้นักพัฒนาคุ้นเคยกับตัวโปรแกรมได้ไม่ยาก

รูปที่ 1-17 แสดงแถบ Toolbox ของโปรเจ็กต์แบบ Windows Forms App
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จากรูปที่ 1-17 แถบคอนโทรล (Control) อยู่ด้านซ้ายมือ ท�ำหน้าที่ออกแบบส่วนแสดงผล 

(User Interface เรียกย่อๆ ว่า UI) ในขั้นต้นนี้ ผู้อ่านสามารถใช้งานคอนโทรลนี้ได้ 2 วิธี

1.	 ดับเบิลคลิกที่ตัวคอนโทรล เพ่ือก�ำหนดให้ Visual Studio ใช้งานคอนโทรลดังกล่าว ใน 

หน้าจอออกแบบโดยอัตโนมัติ เช่น ผู้เขียนต้องการใช้ปุ่มกด button1 ดังรูปที่ 1-18

ลากวาง1

รูปที่ 1-18 แสดงการใช้ปุ่มกดด้วยวิธีการดับเบิลคลิกในแถบ Toolbox

2.	 คลิกเลือกคอนโทรลทีต้่องการใช้งาน แล้วน�ำไปวาดในส่วนของฟอร์ม (Form) ดังรูปที ่1-19

คลิก2.1
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วาด2.2

รูปที่ 1-19 แสดงการใช้ปุ่มกด Button ด้วยวิธีวาด

จากรูปที่ 1-19 เราได้ส่วนแสดงผลง่ายๆ มาแล้ว 1 หน้าจอ มีปุ่มกด Button เพียง 1 ปุ่ม  

ผู้อ่านสามารถออกแบบส่วนแสดงผลได้อย่างอิสระตามที่ต้องการ

การปรับแต่งคอนโทรลขั้นต้นด้วยวิธีแก้ไข
คุณสมบัติ (Property)

คอนโทรลต่างๆ ทีผู้่อ่านน�ำมาใช้งาน ผู้อ่านสามารถปรับแต่งหรือแก้ไขได้ในหน้าต่างคณุสมบติั 

(Properties) กล่าวคือ เมื่อผู้อ่านโฟกัสที่คอนโทรลตัวใดก็ตาม หน้าต่างคุณสมบัติ (Properties) จะ

เปลี่ยนไปโดยอัตโนมัติ

เลือก 1
แสดงผล 2

รูปที่ 1-20 แสดงรายการคุณสมบัติของปุ่มกด Button
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จากรูปที่ 1-20 ส่วนแสดงผลปัจจุบันของผู้เขียนมีเพียง 1 ปุ่ม เม่ือถูกโฟกัสแล้ว หน้าต่าง

คุณสมบัติก็จะแสดงรายการคุณสมบัติต่างๆ ของคอนโทรล Button ให้เราโดยอัตโนมัติ 

รายการคุณสมบัติของคอนโทรล Button ที่น่าสนใจ แสดงดังตารางต่อไปนี้

คุณสมบัติ หน้าที่

Name ท�ำหน้าที่ตั้งชื่อให้กับตัวคอนโทรล ใช้ส�ำหรับอ้างอิงตอนเขียนโค้ด

Text ก�ำหนดข้อความที่จะแสดงในปุ่มกด

BackColor ก�ำหนดสีพื้นหลังให้กับปุ่มกด

ForeColor ก�ำหนดสีตัวอักษรที่อยู่ในปุ่มกด

คุณสมบัตใิดกต็ามทีถ่กูแก้ไข จะแสดงด้วยตวัอกัษรตวัหนา ส่วนตวัอกัษรปกต ิหมายถงึ เป็นค่าเร่ิมต้นทีโ่ปรแกรม 

Visual Studio ตั้งไว้ โดยที่ผู้อ่านไม่จ�ำเป็นต้องไปแก้ไขให้ครบทุกคุณสมบัติ แก้ไขเฉพาะเท่าที่จ�ำเป็น

Note

ผู้เขียนลองใช้คอนโทรล Label ท�ำหน้าที่แสดงข้อความ เม่ือคอนโทรล Label ได้รับโฟกัส  

พบว่าที่หน้าต่างคุณสมบัติ ก็จะแสดงรายการคุณสมบัติของคอนโทรล Label ให้เราโดยอัตโนมัติ

เลือก 1

แสดงผล 2

รูปที่ 1-21 แสดงรายการคุณสมบัติของโทรล Label

รายการคุณสมบัติที่น่าสนใจ แสดงดังตารางต่อไปนี้

คุณสมบัติ หน้าที่

Name ท�ำหน้าที่ตั้งชื่อให้กับตัวคอนโทรล ใช้ส�ำหรับอ้างอิงตอนเขียนโค้ด

Text ก�ำหนดข้อความที่จะแสดงใน Label
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BackColor ก�ำหนดสีพื้นหลังให้กับคอนโทรล Label

ForeColor ก�ำหนดสีตัวอักษรที่อยู่ในคอนโทรล Label

AutoSize ก�ำหนดขนาดของคอนโทรล Label มี 2 แบบคือ
�� True หมายถึง ก�ำหนดให้ Label มีขนาดเท่าที่ข้อความแสดงอยู่
�� False หมายถึง ผู้อ่านสามารถก�ำหนดขนาดของ Label ได้อย่างอิสระ

คอนโทรลแต่ละตัวกจ็ะมีรายการคณุสมบติัทัง้ทีเ่หมือนกนั และต่างกนัไปตามหน้าทีข่องตัวมันเอง

การทดสอบโปรเจ็กต์
หลังจากที่ผู้อ่านออกแบบและเขียนโค้ดแล้ว ก็จะเข้าสู่ข้ันตอนการทดสอบโปรเจ็กต์ว่า มีการ

ท�ำงานหรือมีผลการท�ำงานเป็นไปตามที่เราต้องการหรือไม่ โดยการคลิกปุ่ม   

เพื่อเริ่มต้นทดสอบรันโปรเจ็กต์

คลิก 1

รูปที่ 1-22 แสดงการเร่ิมทดสอบโปรเจ็กต์
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ในกรณีที่ผู้อ่านต้องการหยุดรันโปรเจ็กต์ปัจจุบัน ให้ผู้อ่านคลิกปุ่ม  ดังรูปที่ 1-23

คลิก 1

รูปที่ 1-23 กรณีต้องการหยุดรันโปรเจ็กต์ปัจจุบัน

การยกเลิกฟีเจอร์ Nullable
การสร้างโปรเจ็กต์ทุกประเภทตั้งแต่ .NET 6 เป็นต้นไป ผู้เขียนแนะน�ำให้ผู้อ่านยกเลิกฟีเจอร์ 

Nullable เป็นล�ำดับแรกก่อนเสมอ เพราะว่ายังไม่ได้ใช้ประโยชน์อะไรกับฟีเจอร์นี้ โดยการดับเบิล

คลิกที่ชื่อโปรเจ็กต์ก่อน ดังรูปที่ 1-24

ดับเบิลคลิก1

รูปที่ 1-24 แสดงการยกเลิกฟีเจอร์ Nullable
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จากรูปที่ 1-24 ให้แก้ไขค่าเดิม enable เป็นค่าใหม่ disable เพ่ือยกเลิกการใช้งานฟีเจอร์ 

Nullable

วิธีการจัดเก็บโปรเจ็กต์ .NET
เป้าหมายของวิธีนี้คือ ต้องการลดขนาดไฟล์โปรเจ็กต์ให้มีขนาดเล็กลง โปรเจ็กต์ทุกประเภท

ของ .NET สามารถใช้วิธีการจัดเก็บโปรเจ็กต์แบบนี้ได้ มีขั้นตอนดังนี้

1.	 ให้ผู้อ่านตรวจสอบขนาดโปรเจก็ต์ก่อนปรับปรุง โดยการคลิกขวาแล้วเลือกค�ำส่ัง Properties 

พบว่าขนาดโปรเจ็กต์ 875 KB แสดงดังรูปที่ 1-25

 

รูปที่ 1-25 แสดงขนาดโปรเจ็กต์ก่อนปรับปรุง

2.	 การปรับปรุงขนาดโปรเจ็กต์ .NET ท�ำได้โดยการเข้าไปในโฟลเดอร์ย่อยระดับแรกก่อน  

ผู้อ่านสามารถลบโฟลเดอร์ .vs ออกได้เลย ดังรูปที่ 1-26
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ลบ 2

รูปที่ 1-26 แสดงการลบโฟลเดอร์ .vs

3.	 เข้าไปในโฟลเดอร์ย่อยอีก 1 ระดับ ให้ลบโฟลเดอร์ bin และ obj ออก ถือว่าเสร็จสิ้นแล้ว 

ดังรูปที่ 1-27

ลบ 3

รูปที่ 1-27 แสดงการลบโฟลเดอร์ย่อย bin และ obj

4.	 ให้ลองตรวจสอบขนาดโปรเจ็กต์อีกครั้ง พบว่าขนาดโปรเจ็กต์จะลดลงแล้ว ผู้อ่านสามารถ

น�ำโปรเจ็กต์ .NET ไปจัดเก็บได้แล้ว ดังรูปที่ 1-28
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รูปที่ 1-28 แสดงขนาดโปรเจ็กต์หลังปรับปรุงแล้ว

5.	 การเปิดโปรเจ็กต์ที่มีการปรับปรุงแบบน้ี ต้องรอให้เคร่ืองหมายอัศเจรีย์ (!) ในหน้าต่าง 

Solution Explorer หายไปก่อน ก็จะใช้งานโปรเจ็กต์ได้ตามปกติ

รูปที่ 1-29 แสดงการเปิดโปรเจ็กต์ที่มีการปรับปรุงขนาด

สรุปท้ายบท

เน้ือหาในบทน้ี เป็นการเตรียมความพร้อมก่อนเข้าสู่การเขียนโปรแกรมด้วยภาษา C# บน

แพลตฟอร์มของ .NET ในบทถัดไป
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25บทที่ 2 พื้นฐานการท�ำงานกับโปรเจ็กต์ประเภท Windows Forms App (.NET)

C# 11บทที่

2
พื้นฐานการท�ำงานกับโปรเจ็กต์ประเภท 
Windows Forms App (.NET)

ฟอร์ม (Form) ท�ำหนา้ที่เหมือนกับเป็นตัวบรรจุ (Container) คอนโทรลตา่งๆ เพื่อสร้างส่วน

แสดงผลตามที่ผู้อา่นออกแบบไว้ เนื้อหาในบทนี้ เราจะมาดูกันว่ามีอะไรน่าสนใจในขั้นต้นบ้าง

ท�ำความรู้จักกับฟอร์ม (Form)
เม่ือผู้อ่านสร้างโปรเจก็ต์แบบ Windows Forms Application กจ็ะได้ฟอร์ม (Form) ทีมี่ช่ือว่า Form1 

เป็นหน้าจอเร่ิมต้น เรามักจะก�ำหนดให้แบบฟอร์มอยู่กึ่งกลางหน้าจอ (หรือกึ่งกลางส่วนแสดงผล 

เสมอ) โดยการก�ำหนดคุณสมบัติ StartPosition เท่ากับ CenterScreen ดังรูปที่ 2-1

เลือก1

รูปที่ 2-1 แสดงรายการคุณสมบัติของฟอร์ม
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คู่มือ Coding และพัฒนาแอปพลิเคชันด้วย C# ฉบับสมบูรณ์

จากรูปที่ 2-1 เมื่อผู้อา่นโฟกัสที่ Form1 หนา้ต่างคุณสมบัติก็จะแสดงรายการคุณสมบัติของ 

Form1 เช่นกัน 

คุณสมบัติของ Form ที่ส�ำคัญ
คุณสมบัติของ Form ที่ส�ำคัญ แสดงดังตารางต่อไปนี้

คุณสมบัติ หน้าที่

Name ท�ำหน้าที่ตั้งชื่อให้กับฟอร์ม ใช้ส�ำหรับอา้งอิงตอนเขียนโค้ด

Text ก�ำหนดข้อความที่จะแสดงในแถบ Title Bar

BackColor ก�ำหนดสีพื้นหลังให้กับฟอร์ม

ForeColor ก�ำหนดสีตัวอักษรที่อยู่ในฟอร์ม

FormBorderStyle ก�ำหนดรูปแบบเส้นขอบของฟอร์ม โดยที่
�� None หมายถึง ไม่มีแถบไตเติลบาร์
�� FixedSingle หมายถึง ปรับขนาดฟอร์มไม่ได้ แต่มีปุ่ม Minimize, Maximize 

และปุ่ม Close
�� Fixed3D หมายถึง ก�ำหนดให้มีเส้นขอบแบบ FixedSingle แต่มีแนวลึกด้วย
�� FixedDialog หมายถึง ก�ำหนดให้เป็นแบบ FixedSingle แต่ใช้ในรปูแบบไดอะลอ็ก 

โต้ตอบกับผู้ใช้งาน
�� Sizable หมายถึง แบบฟอร์มปรับขนาดได้
�� FixedToolWindow หมายถงึ แบบฟอร์มปรบัขนาดไม่ได้ และไม่มปีุม่ Minimize 

และปุ่ม Maximize
�� SizableToolWindow หมายถงึ แบบฟอร์มปรบัขนาดได้ และไม่มปีุม่ Minimize 

และปุ่ม Maximize

MaximizeBox ก�ำหนดให้แบบฟอร์มแสดงปุ่มขยายขนาดฟอร์ม โดยที่
�� True หมายถึง ให้มีปุ่ม Maximize มุมขวา-บน
�� False หมายถึง ซ่อนปุ่ม Maximize 

MinimizeBox ก�ำหนดให้แบบฟอร์มแสดงปุ่มย่อขนาดฟอร์ม โดยที่
�� True หมายถึง ให้มีปุ่ม Minimize มุมขวา-บน
�� False หมายถึง ซ่อนปุ่ม Minimize 

IsMdiContainer ก�ำหนดให้ฟอร์มท�ำหน้าที่บรรจุฟอร์มอื่นๆ แบบหลายหน้าตา่งได้หรือไม่ โดยที่
�� True หมายถึง ก�ำหนดให้ฟอร์มเป็นตัวบรรจุแบบ MDI
�� False หมายถึง ก�ำหนดให้เป็นแบบฟอร์มปกติ
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C# 11คุณสมบัติ หน้าที่

WindowState ก�ำหนดขนาดของฟอร์ม โดยที่
�� Normal หมายถึง ก�ำหนดให้ฟอร์มมีขนาดตามที่เราออกแบบ
�� Minimized หมายถึง ก�ำหนดให้ฟอร์มมีขนาดย่อลงในแถบ Taskbar
�� Maximized หมายถึง ก�ำหนดให้ฟอร์มมีขนาดเต็มหน้าจอส่วนแสดงผล

การเพิ่มฟอร์มใหม่เข้ามาในโปรเจ็กต์
ในการพัฒนาแอปข้ึนมาใช้งาน ย่อมที่จะต้องประกอบไปด้วยส่วนแสดงผลต้ังแต่ 2 หน้าจอ 

ขึ้นไป วิธีการเพิ่มหนา้จอใหม่เขา้มา ให้ผู้อ่านคลิกเมนู Project > Add Form (Windows Forms)… 

ในกรณีน้ี เราต้องการเพ่ิมหน้าจอใหม่ประเภท Windows Forms Application ต้ังช่ือว่า Form2  

ดังรูปที่ 2-2

คลิก1

ต้ังชื่อฟอร์ม2
คลิก 3
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รูปที่ 2-2 แสดงการเพิ่มฟอร์มที่ช่ือว่า Form2 เข้ามาในโปรเจ็กต์

จากรูปที่ 2-2 ณ จุดนี้โปรเจ็กต์ของเรามี 2 ฟอร์ม โดยปกติแล้วจะก�ำหนดให้ Form1 รันเป็น

ล�ำดับแรกเสมอ ผู้อ่านสามารถแก้ไขได้ทีค่ลาส Program เช่น ต้องการให้ Form2 ปรากฏเป็นล�ำดับแรก  

ดังรูปที่ 2-3

ระบุชื่อ Form2 1

รูปที่ 2-3 แสดงการก�ำหนดให้ Form2 ปรากฏขึ้นมาเป็นล�ำดับแรก

วิธีการสั่งให้เปิดฟอร์มใหม่โดยการ 
เขียนโค้ด

ส�ำหรับวิธีการสั่งให้เปิดฟอร์มใหม่ที่เราเพิ่มเข้ามา มีขั้นตอนดังนี้

1.	 ใน Form1 เพ่ิมปุ่มกด button1 เข้ามาก่อน ให้ผู้อ่านดับเบิลคลิกปุ่มกด button1 เพ่ือ 

สร้างเหตุการณ์ Click() 
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ดับเบิลคลิก1.1

ดับเบิลคลิก1.2

ได้เหตุการณ์ Click() ของปุ่มกด button11.3

รูปที่ 2-4 แสดงโค้ดที่ใช้ส�ำหรับเปิด Form2

2.	 จากน้ันเขียนโค้ดดังต่อไปนี้

Form1.cs

namespace BasicForm
{
	 public partial class Form1 : Form
	 {
		  public Form1()
		  {
			   InitializeComponent();
		  }

		  private void button1_Click(object sender, EventArgs e)
		  {
			   Form2 frm = new Form2();
			   frm.Show();
		  }
	 }
}
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การท�ำงานของโค้ดข้างต้นคอื ในเหตุการณ์ Click() ของปุม่กด Button ทีช่ื่อว่า button1 ให้ท�ำ

�	 สร้างตัวแปรออบเจ็กต์ Form2 ที่ชื่อว่า frm (Form2 frm = new Form2()) ขึ้นมาก่อน

�	 ส่ังให้ Form2 ปรากฏข้ึนมา ผ่านทางตัวแปร frm ร่วมกับเมธอด Show() (frm.Show()) 

3.	 ให้ผู้อ่านทดสอบรันโปรเจ็กต์ พบว่าเราสามารถเปิด Form2 ได้แล้ว ดังรูปที่ 2-5

แสดงผล3.2

คลิก3.1

รูปที่ 2-5 Form2 ที่ถูกเปิดจากปุ่มกด button1 ใน Form1

หลักการเขียนโปรแกรมแบบ Event Driven 
Programming

หลักการท�ำงานพ้ืนฐานของโปรเจก็ต์ประเภท Windows Forms Application เรียกว่า การเขียน 

โปรแกรมตอบสนองเหตุการณ์ที่เกิดขึ้น (Event Driven Programming) กล่าวคือ ผู้อ่านเป็น 

ผู้ก�ำหนดเองว่า เม่ือเกดิเหตุการณ์ Click() ให้ท�ำอะไร, เม่ือเกดิเหตุการณ์ Load() ให้ท�ำอะไร เป็นต้น

หมายความว่า การกระท�ำต่างๆ ที่ผู้ใช้งานกระท�ำต่อโปรแกรม ผู้อ่านเป็นผู้ก�ำหนดขึ้นมาเอง

ทั้งส้ินว่า "ให้ท�ำอะไร" ประเด็นที่ตามมาคือ วิธีการสร้างเหตุการณ์ให้กับคอนโทรลแต่ละตัว ท�ำ

อย่างไร ล�ำดับโค้ดมาก่อนไม่ได้หมายความวา่โค้ดท�ำงานก่อน โค้ดท�ำงานตามเหตุการณ์ที่เกิดขึ้น

สมมติว่าผู้เขียนต้องการสร้างเหตุการณ์ Click() ให้กับปุ่มกด Button การสรา้งเหตุการณ์ให้

กับปุ่มกด button1 นี้ มี 2 วิธี
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1.	 ดับเบิลคลิกที่คอนโทรล button1 เพ่ือส่ังให้ VS 2022 สร้างเหตุการณ์ประจ�ำตัวของ

คอนโทรล Button ขึ้นมา คอนโทรล Button ถูกสรา้งขึ้นมาเพื่อท�ำหน้าที่รองรับการคลิก

จากผู้ใช้งาน ส่งผลให้เหตุการณ์ประจ�ำตัวของคอนโทรล Button ก็คือ เหตุการณ์ Click()

ดับเบิลคลิก1.1

เหตุการณ์ Click()1.2

รูปที่ 2-6 แสดงการสร้างเหตุการณ์ Click() ด้วยวิธีดับเบิลคลิก

คอนโทรลแต่ละตัวมีเหตุการณ์ประจ�ำตัวแตกต่างกัน ขึ้นอยู่กับวา่ คอนโทรลตัวนั้นๆ ถูกสร้าง

ขึ้นมาเพื่อ "ท�ำหน้าที่อะไร"

2.	 การสร้างเหตุการณ์อีกวิธีหนึ่งคือ ให้ผู้อา่นโฟกัสที่คอนโทรล button1 ก่อน จากนั้นคลิก

ปุ่ม  ในหนา้ต่าง Properties เพ่ือเลือกสร้างเหตุการณ์ที่เราต้องการ จะเห็นได้วา่ ปุ่มกด 

Button รองรับหลายเหตุการณ์ ให้ผู้อา่นดับเบิลคลิกที่ Click เพื่อสร้างเหตุการณ์ Click() 

ขึ้นมาส�ำหรับปุ่มกด button1 ปุ่มนี้
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เลือก2.1

ดับเบิลคลิกเพื่อสร้างเหตุการณ์ Click2.2

รูปที่ 2-7 แสดงเหตุการณ์ Click() ที่ได้จากวิธีเลือกสร้างเหตุการณ์

ผู้เขียนลองต้ังโจทย์ง่ายๆ ว่า ต้องการแสดงข้อความ "Hello C#" เม่ือผู้ใช้งานคลิกปุ่ม  

button1 ดังโค้ดต่อไปนี้

Form1.cs

namespace BasicForm
{
	 public partial class Form1 : Form
	 {
		  public Form1()
		  {
			   InitializeComponent();
		  }

		  private void button1_Click(object sender, EventArgs e)
		  {
			   MessageBox.Show("Hello C#", "ค�ำทักทาย");
		  }
	 }
}

IG-0448 Inbook.indb   32 29/9/2566   7:34:55



33บทที่ 2 พื้นฐานการท�ำงานกับโปรเจ็กต์ประเภท Windows Forms App (.NET)

C# 11

จากโค้ดขา้งต้น เป็นการสั่งให้แสดงข้อความ "Hello C#" โดยอาศัยคลาส MessageBox เขา้มา

ท�ำหน้าที่สร้างไดอะล็อกแสดงข้อความ ดังรูปที่ 2-8

คลิก2.1

แสดงผล2.2

รูปที่ 2-8 แสดงข้อความที่ได้

3.	 ในกรณีทีผู้่อ่านดับเบลิคลิกบริเวณพ้ืนทีว่่างๆ ของ Form1 ส่งผลให้ C# กจ็ะสร้างเหตุการณ์ 

Load() ข้ึนมา เหตุการณ์ประจ�ำตัวของ Form กค็อื เหตุการณ์ Load() เพ่ือให้ผู้อ่านก�ำหนด

วา่ เมื่อ Form1 ถูกโหลดขึ้นมาแล้วให้ท�ำอะไร

รูปที่ 2-9 แสดงเหตุการณ์ Form1_Load()
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พื้นฐานการใช้งานฟอร์มแบบ MDI  
และสร้างระบบเมนู (Menu)

ฟอร์ม (Form) ท�ำหน้าที่เป็นตัวบรรจุ (Container) คอนโทรลต่างๆ ที่ผู้อ่านเรียกใช้งานอยู่  

โดยทีใ่นแอปพลิเคชันชนิด Windows Application 1 ตัว จะต้องประกอบไปด้วยฟอร์มอย่างน้อยทีสุ่ด 

1 ฟอร์ม เพื่อท�ำหน้าที่เป็นส่วนแสดงผลให้กับผู้ใช้ (เรียกวา่ User Interface - UI) รูปร่างหนา้ตา

โปรแกรมของผู้อ่านจะเป็นอยา่งไร ก็จะขึ้นอยู่กับการออกแบบฟอร์มของผู้อา่นนั่นเอง 

เราสามารถแบ่งลักษณะของฟอร์มได้ 2 ลักษณะคือ

�	 การใช้งานฟอร์มแบบ SDI (Single Document Interfaces) หมายถึง แอปพลิเคชันที่

สามารถเปิดเอกสารได้เพียงคร้ังละ 1 เอกสาร หรือแสดงผลส่วนติดต่อกับผู้ใช้ได้คร้ังละ 

1 หน้าจอ 

�	 การใช้งานฟอร์มแบบ MDI (Multiple Document Interfaces) หมายถึง การใช้งาน

ฟอร์มที่สามารถแสดงส่วนแสดงผล หรือส่วนติดต่อกับผู้ใช้ได้มากกวา่ 1 หน้าจอในเวลา 

เดียวกัน โดยที่จะมี 1 ฟอร์ม ท�ำหน้าที่เป็นฟอร์มแม่ เรียกวา่ Parent Form ท�ำหนา้ที่บรรจุ

ฟอร์มลูกที่เรียกวา่ Child Form 

ตัวอย่างที่ 2-1 พื้นฐานการใช้งานฟอร์มแบบ MDI มีขั้นตอนดังนี้

1.	 สร้างโปรเจ็กต์ที่ชื่อว่า UsingMDIForm เปลี่ยนชื่อฟอร์ม Form1 เป็น frmMain ก่อนเพื่อท�ำ

หนา้ที่เป็นฟอร์มหลักของโปรเจ็กต์ ดังรูปที่ 2-10

 

แก้ไขชื่อฟอร์มเป็น frmMain1.1
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คลิกขวา1.2

แก้ไขชื่อฟอร์มเป็น frmMain1.3

รูปที่ 2-10 แสดงการเปล่ียนช่ือฟอร์มเป็น frmMain

2.	 ก�ำหนดให้ฟอร์มน้ีเป็นฟอร์มหลัก MDI ท�ำหน้าที่บรรจุฟอร์มลูกต่างๆ โดยการก�ำหนดที่

คุณสมบัติ IsMdiContainer = True ดังรูปที่ 2-11

เลือกค่า True2

รูปที่ 2-11 แสดงการก�ำหนดให้ฟอร์มนี้ท�ำหน้าที่เป็นฟอร์มหลัก MDI
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คู่มือ Coding และพัฒนาแอปพลิเคชันด้วย C# ฉบับสมบูรณ์

3.	 ให้ผู้อ่านคลิกเมนู Project > Add Form (Windows Forms)… เพื่อเพ่ิมฟอร์มใหม่เข้ามาใน

โปรเจ็กต์ ตั้งชื่อวา่ frmChild ท�ำหนา้ที่เป็นฟอร์มลูก ดังรูปที่ 2-12

เลือก3.1

เลือก3.2

ต้ังชื่อฟอร์มว่า frmChild.cs3.3
คลิก 3.4

ฟอร์มที่เพิ่มเข้ามา3.5

รูปที่ 2-12 แสดงฟอร์มลูกที่ถูกเพิ่มเข้ามาในโปรเจ็กต์
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